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Introduction 
These consolidated reference materials apply to the ZTDR™ software included with all HL11xx TDR instruments 
from HYPERLABS. The same software package is compatible with all instruments in this series. 

ZTDR™ is compatible with Microsoft Windows® XP, Vista, 7, and 8. For deployment in other applications, a free 
DLL is available on the HYPERLABS website. 

For further technical support, please visit our website: www.hyperlabsinc.com/support.aspx 
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Section 1: Changelog 
Below is a list of major software improvements and features added in various releases of ZTDR™. To ensure that 
you are always using the most recent version of ZTDR™, please bookmark our website: 
http://www.hyperlabsinc.com/ZTDR.aspx 

Version 2.0 

• Software multithreading has been introduced, providing a more responsive user interface and seamless 
data acquisition routines. 

• Due to multithreading, there is no longer a performance detriment to frequent auto-calibration. For this 
reason, we have removed the option to disable automatic amplitude calibration. 

• A green status indicator LED has been added to indicate an in-progress data acquisition or recalibration. 
More information about this feature can be found in Section 13 below. 

• The Data menu has been removed, and all data logging options have now been moved to the File menu. 

Version 1.1 

• We have added the ability to set a horizontal zero reference. This is available from the Calibration menu. 

• Program settings can now be saved and loaded on demand. Acquisition environment settings are also 
saved and loaded automatically at program startup and shutdown. 

Section 2: Instrument Operation 
All HYPERLABS instruments are controlled via USB. The ZTDR™ software and drivers are compatible with all 
versions of Windows XP, Windows Vista, Windows 7, and Windows 8. At this time, we have no plans to port the 
ZTDR™ user interface to OS X, Linux, or other operating systems. 

HYPERLABS also provides a free DLL for ZTDR™ which can be used with other applications and operating 
systems. For additional information about the DLL, please visit our website. 

The instrument should always be plugged into the PC prior to running the ZTDR™ software. A green LED on the 
back panel of the instrument will indicate that it is plugged into a working USB port. 

Section 3: Static Sensitivity and Protection 
Instruments in the HL11xx series are complaint with Class 2 of ESDS Component Sensitivity Classification (ESD 
STM5.1-1998). Additional static protection is not required to use these instruments in most applications. 
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Section 4: Driver and Software Installation 
HYPERLABS instruments utilize third-party drivers from FTDI. On internet-connected computers, the latest signed 
drivers will be automatically downloaded and installed as soon the instrument is plugged in to a working USB port. 

If the computer is not connected to the internet or not configured for automatic driver installation, the FTDI drivers 
must be manually installed. Please visit the following page to download the latest version of the FTDI drivers: 
http://www.ftdichip.com/Drivers/D2XX.htm 

If the program states it cannot find “FTD2xx.dll”, download the driver package at the address above, extract the 
.ZIP file, and copy the FTD2xx.dll file into the installation directory listed below. 

Once the FTDI driver is installed, the ZTDR™ software can be installed by running “setup.exe” in the included 
install package. If the package is in compressed (.zip) format, all files must be extracted prior to installation. 

By default, the software will install to the following directory: “C:\HYPERLABS\ZTDR\” 

During installation, the user may elect to install to a different directory. No other user options are available during 
the installation process. 

Section 5: Running the ZTDR™ Software 
The instrument is initialized and calibrated at startup, a process that takes a few seconds. The software will not be 
responsive to user input during that time. When this process is complete, the operator will see the user interface 
shown on the following page. A message in the right-side panel will say “Calibration… DONE!” 

NOTE: For optimal results, the instrument should be plugged in for a 5 minute “warm up” period prior to use. After 
warmup, the operator should recalibrate the instrument (see Section 15 below). 
If any error messages are shown, please make sure that the instrument is plugged in and the drivers installed 
(see Sections 2-4 above) before contacting HYPERALBS for additional support. 
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Section 6: Overview of ZTDR™ Software and Display Controls 
When the ZTDR™ software is running, the user will see a screen similar to Figure 1 below. 

This User Manual is organized according to ZTDR™ control functionality. Please see the Table of Contents for a 
list of the controls covered in the sections below. 

Section 7: Waveform Display 
ZTDR™ displays waveforms in the time domain, i.e. as a function of time or distance. 

The horizontal axis shows ROUNDTRIP time or distance. Units can be changed using the X Units menu (see 
Section 10.1 below). The acquisition window START and END points and the DIELECTRIC K can also be 
changed on demand (see Sections 10.2-10.3 below). 

The operator can adjust the vertical display using the Y Units menu (see Section 10.1 below) and the scaling 
controls found in the right panel (see Section 11.2 below). 

The operator can also position the cursors on the waveform using drag-and-drop (see Section 8 below). No other 
actions can be performed directly on the Waveform Display. 

For further help reading the actual waveform output, please review the Application Guides on our website, or 
contact HYPERLABS for assistance. 

  

Figure 1: ZTDR™ software after initialization and calibration 
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Section 8: Cursor Readings 
ZTDR™ has two cursors which can be used to take spot measurements on the Waveform Display. C1 is blue, 
and C2 is red. These cursors can be positioned by dragging and dropping them on the waveform. 

Cursor readings are found in the right-hand panel of the ZTDR™ software, as 
shown in Figure 2 at right. The grey +/- box displays the horizontal and vertical 
difference between the two cursors in the selected units. 

NOTE: The cursors always snap to the closest point on the waveform, so the 
cursors will jump slightly as each waveform is acquired. For the most accurate 
cursor readings, HYPERLABS recommends switching to manual acquisition 
before positioning the cursors or logging the results. 

Section 9: Display Options 
In the Display menu found at the top of the ZTDR™ interface, the operator can control the look of the Waveform 
Display. These options are aesthetic, and do not impact the way in which the waveform is acquired. 

There are three options for displaying the plot itself. In the default Dots mode, each acquired data point is 
displayed individually. In Thin Line and Thick Line modes, the data points are connected with vectors. This 
option affects only the active waveform. For ease of reading, recalled waveforms (see Section 14 below) are 
always displayed as a thin magenta line. 

The color scheme is also adjustable. A Dark Background shows bright waveform on a dark grid, similar to most 
test and measurement instruments. The Light Background is useful for saving toner when printing the data. 

  

Figure 2: Example cursor 
readings in m, mV 
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Section 10: Horizontal Axis Controls 
Horizontal Controls impact the way in which the waveform is displayed by the ZTDR™ software. Combined with 
the Vertical Axis Controls (see Section 11 below), these allow the operator to customize the test environment. 

Section 10.1: Horizontal Units 
The horizontal axis is displayed in DISTANCE (m), DISTANCE (ft), or TIME (ns). The unit of measure can be 
changed using the X Units menu bar. When a unit is chosen, a new waveform will be acquired and displayed in 
the selected horizontal units. 

Any horizontal unit can be used to locate faults, measure impedance, or otherwise analyze the device under test. 
Accurate distance readings are dependent on having set the proper Dielectric Constant (see Section 10.3 below). 

Section 10.2: Window Start and End 
The START and END points of the waveform acquisition window can be set by either entering a numerical value 
or adjusting the appropriate slider. These controls use the active horizontal unit (see Section 10.1 above). 

A minimum window width is required for data acquisition. If END is set too close to START (within 1 m, 3 ft, or 5 
ns), the software will automatically adjust END to satisfy the minimum width. 

NOTE: The waveform consists of 1024 equidistant data points, and ZTDR™ automatically sizes the acquisition 
window as closely as possible to the desired width. Rounding may result in a slightly smaller acquisition window. 

Section 10.3: Dielectric Constant (K) and Velocity of Propagation (V/C) 
Because electrical signals propagate at different speeds through different materials, ZTDR™ gives the operator 
the ability to customize the DIELECTRIC K. Below this control, the V/C box shows the velocity of propagation as 
a ratio of the speed of light. V/C is derived from DIELETRIC K, and cannot be changed manually. 

Some common materials and their K and V/C values are listed here. 

Material K V/C 

Coaxial cable with polyethylene insulation 2.25 0.6667 

Coaxial cable with Teflon insulation 2.06 0.6967 

Aluminum Oxide (Alumina) 9.8 0.3194 

Figure 3: Table of Dielectric Constants for Common Materials 

 

 

Section 10.4: Cursor-based Zoom 
The cursors can also be used to zoom in on any portion of the waveform. To do this, place Cursor 1 on the left 
edge of the area to be magnified, and Cursor 2 to the right. Then click the ZOOM button found below the 
waveform. To reset the horizontal scale to their default values, simply click the RESET ZOOM button.  
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Section 11: Vertical Axis Controls 
The vertical axis controls of the ZTDR™ software are similar to the horizontal controls (see Section 10 above). 

Section 11.1: Vertical Units 
The Y Units menu changes the units displayed on the vertical axis of the Waveform Display Area. Options 
include: Volts (mV), Normalized, Impedance (Ohm), and Reflection Coefficient (Rho). 

Different vertical units provide different types of information about the device under test. The fundamental shape 
of the waveform does not differ between mV, Norm, and Rho. In Ohm, the shape is somewhat distorted due to 
the fundamental way in which impedance is calculated. 

For recommendations on which units to use in specific test environments, please reference Figure 5 on the next 
page or contact HYPERLABS. Proper values for the upper and lower limits depend on the selected vertical unit, 
and can also be found in Figure 5. 

Section 11.2: Vertical Limits and Scaling 
The Waveform Display can be set to AUTOSCALE Y-AXIS, or to manual scaling. The 
user can toggle the mode using the controls in the right-side panel, show in Figure 4 in 
greater detail. 

If the software is set to manual scaling, the user can adjust the limits of the vertical axis 
using the controls shown in Figure 4 at right. In AUTOSCALE mode, the limits controls 
are dimmed. 

Figure 5 below shows the default limits of each unit type when in manual scaling mode. 

Figure 5: Recommended Vertical Scale for Each Unit Type 

  

UNITS Lower Limit Upper Limit Description 

Voltage (mV) -250 250 Default setting, measures the reflected voltage of the 250 mV 
incident pulse 

Normalized Voltage 0 2.0 Reflected voltage represented as a fractional value, where 0 
indicates the initial value, 1.0 indicates the normalized incident 
step (250 mV), and 2.0 indicates an open (full reflection) 

Impedance (Ω) 0 500 Impedance, in Ohms (Ω), of the device under test 

Reflection Coefficient (Rho) -1.0 1.0 Coefficient used to calculate impedance, where 0.0 represents 
50 Ω;  Impedance (Z) = 50 * (1 + Rho) / (1 - Rho) 

Figure 4: Y axis 
scaling controls 



 

User Manual and Technical Guide for HYPERLABS ZTDR™  Page 9 
 

Section 12: Waveform Acquisition and Averaging 
The operator can control the frequency of waveform acquisition and toggle 
between automatic and manual acquisition. This is done using the controls 
found in the right-hand panel, and shown at right in Figure 6.  

By default, ZTDR™ operates in AUTO acquisition mode. In this mode, 
waveforms are acquired and displayed on the Waveform Display at regular 
intervals. 

Alternatively, the software can be set to manual mode. In this mode, the software acquires and displays a single 
waveform whenever the operator clicks the orange ACQUIRE button. 

Multiple waveforms can be taken using the AVERAGING control, found above the 
message box in the right-hand panel, and shown in Figure 7 at right.  

On each acquisition, the software acquires the desired number of waveforms, cycles 
through them, and displays the average as a single waveform. The default value is 1, 
which indicates that a single waveform is acquired. 

NOTE: As of ZTDR™ Version 2.0, software multithreading eliminates the need to turn 
off automatic acquisition while using waveform averaging. 

Section 13: Program Log and Status Indicator 
ZTDR™ displays messages and status updates to the user in the 
Program Log found in the right-hand panel of the instrument, shown 
in Figure 8 at right. 

In Version 2.0, as green status indicator LED has also been added 
above the Program Log. While this is lit up, a calibration or data 
acquisition is in progress. 

The software also displays a timestamp for each waveform 
acquisition. This is displayed immediately below the message pane, in 
green text. 

 

  

Figure 7: Waveform 
Averaging Control 

Figure 6: Waveform 
Acquisition Control 

Figure 8: Sample Program Log, 
timestamp, and active status indicator 

LED 
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Section 14: Data Logging and Storage 
ZTDR™ has a variety of logging features to simplify the storage of data obtained during testing. As of Version 2.0, 
these controls are now found in the File menu in the main program menu bar. 

Section 14.1: Printing 
When the user selects the Print menu option, ZTDR™ formats the waveform acquisition for printing. To save ink, 
the color scheme is automatically switched to Light Background, and switched back once printing is complete. 

Section 14.2: CSV Logging 
The Save CSV menu item in ZTDR™ saves the waveform data to a comma-separated values (.csv) file. This raw 
data can be used for data storage or post-processing in other software. 

The structure of the CSV file is simple. The first column contains the horizontal values, and the second contains 
the vertical values. The header row shows the horizontal (m, ft, or ns) and vertical units (mV, norm, Ohm, Rho) 
used to acquire the waveform. 

For simplicity of post-processing, the CSV file does not include a timestamp or serial number. We recommend that 
the user store this data in the filename for later reference. 

Section 14.3: Saving to PNG 
Using Save PNG feature, the operator can save the waveform and ZTDR™ window to a PNG image file. The 
user can select the directory to save the file, but no other options are available. 

Section 14.4: Storing and Retrieving Waveforms 
In ZTDR™, waveforms can be stored and retrieved later as an on-screen reference for subsequent tests. 

The Store Waveform menu item captures the waveform on the screen and saves it to a waveform file (.ztdr). The 
Recall Waveform option is used to load old waveforms into the Waveform Display as a magenta plot. The Clear 
Waveform menu option removes the stored waveform from the screen. 

NOTE: When a waveform is loaded, the horizontal and vertical scale and unit controls are set to the parameters 
used for the original measurement, and cannot be changed. 
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Section 15: Horizontal Reference (Zero) Point 
The horizontal reference (zero) can now be changed in ZTDR™. Options to set and reset the horizontal offset can 
be found in the Calibration menu located in the main program menu bar. 

Section 15.1: Set the Horizontal Reference 
The horizontal reference point feature sets the 0.0 time or distance to the point on the waveform where the step 
goes to open. The system must be in open (i.e. unterminated, no short circuit) in order for this feature to work. 

The reference point can be set to either the output port of the TDR instrument, or to the end of a reference cable 
being used in the test setup. As long as the step to open can be seen in the current acquisition window, this 
feature will work. 

Clicking the Set Zero menu option opens a prompt reminds the user to put the test system in open. Clicking the 
Yes button performs the function, while clicking No cancels it. 

When the Horizontal Reference feature is active, the START and END window boxes will appear as a shade of 
light yellow, and the 0.0 point will be positioned somewhere in the middle of the waveform. This is shown in Figure 
9 below. 

Section 15.2: Resetting Horizontal Reference 
To remove the horizontal offset, click the Reset Zero menu option found in the Calibration menu. This resets the 
axis to the very beginning of the waveform.  

Figure 2: Waveform with Horizontal Reference set to outside panel of instrument 
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Section 16: Instrument Calibration 
All HYPERLABS TDRs have an internal calibration feature, and the instrument automatically calibrates at 
software startup. Calibration can also be performed during data collection. To use these features, use the 
Calibration menu located in the main program menu bar. 

Section 16.1: Vertical and Timescale Calibration 
There are two types of calibration built into ZTDR™, regular amplitude Recalibration and extended Timebase 
Calibration. Either can be performed using the Calibration menu at the top of the user interface. The status of 
every calibration attempt is shown in the Message Log box. 

NOTE: The “Vert Cal” option from previous ZTDR™ versions is now simply called “Recalibration”. The 
functionality of this feature has not changed. 

When an amplitude Recalibration is performed, the instrument is quickly calibrated to within 1% of a of high-
quality 50 Ω semi-rigid coaxial cable found within the instrument housing.  

ZTDR™ automatically performs an amplitude calibration every 30 seconds. As of Version 2.0, it is no longer 
possible to disable automatic recalibration. 

The Timebase Cal feature recalibrates the entire instrument, including both the timebase and the amplitude. This 
“extended” calibration is performed at instrument startup. It can also be performed on demand, but it is generally 
not necessary once the instrument is warmed up.. 

NOTE: For optimal accuracy, HYPERLABS recommends letting the instrument warm up for approximately 5 
minutes before use. Warmup can be performed simply by plugging the instrument into a USB port. ZTDR™ does 
not need to be running during warm up. Once the warmup is complete, click Timebase Cal to recalibrate. 

Section 16.2: NIST Certification 
Each instrument, including the internal reference cable, is calibrated by HYPERLABS using NIST-traceable 
equipment at the time of initial shipment.  

If regular NIST re-certification is required, the instrument can be sent to HYPERLABS periodically for calibration 
and certification. At the time of service, HYPERLABS will verify the unit using NIST-traceable instruments and 
provide a certificate of calibration. Please see our website for current pricing and RMA procedures. 
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Section 17: Save and Load Settings 
ZTDR™ is capable of saving test environment variables for use in subsequent test sessions. The stored variables 
are: dielectric constant K, vertical units, vertical minimum/maximum, horizontal units, window start, 
window end, horizontal offset, auto scaling, and auto acquisition. 

These settings can be saved and loaded on demand. When starting ZTDR™, the program also auto-loads the 
test settings in use in the most recent test session. 

Section 17.1: Automatic Settings Save and Recall 
The first time ZTDR™ is run, the default test environment settings are used. When the user exits the program, the 
active settings are stored in the “user.ini” file found in the main program directory. The next time the program 
runs, it automatically loads these settings. 

If the startup settings become corrupt, delete “user.ini” and a new one will be created the next time ZTDR™ runs. 

Section 17.2: Saving and Loading Settings on Demand 
To save the environmental settings for later use in ZTDR™, select the Save Settings option from the File menu. 
Settings are stored in an .ini file of the user’s choosing. The default save location is the settings folder found in 
the main program directory. 

Use the Load Settings option in the File menu to retrieve stored settings. This action immediately overrides all 
active settings. 

Section 17.3: Restoring Default Settings 
If the user wants to revert to default ZTDR™ settings (measurement units, window, etc.), this can be 
accomplished using the Reset Defaults option in the File menu. 

Sometimes, a settings file will become corrupt and unusable. If this happens, ZTDR™ will alert the user and 
revert to default settings automatically. 
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Section 18: Additional Resources 
This manual for HYPERLABS ZTDR™ is primarily intended to cover instrument setup and familiarize the user 
with the major features of the hardware and software. The applications for TDRs are too many and varied to cover 
fully in this User Manual. 

Accordingly, we have made a wide variety of Application Guides and other reference materials on our website. A 
full listing of Application Guides can be found at: http://www.hyperlabsinc.com/application-guides.aspx 

If help for your application isn’t provided in our Application Guides, HYPERLABS is always happy to provide 
unlimited technical support to our customers. For up-to-date telephone or email support options, please see our 
webpage: http://www.hyperlabsinc.com/contact-us.aspx 

Section 19: Copyright Information 
The information contained in this User Manual is © 2015 by HYPERLABS INC. This manual may be freely 
distributed as-is, but any translations, edits, or revisions are prohibited unless expressly approved by 
HYPERLABS. 

The ZTDR™ software title and screenshots, and all instrument model numbers (e.g. HL11xx) listed in this User 
Manual are also © 2015 by HYPERLABS, Inc. 

The “HL Circle” and HYPERLABS logo found at the top of each page of this User Manual are © 2012-2014 by 
HYPERLABS INC. 

Windows® is a registered trademark of the Microsoft Corp., which is not affiliated with HYPERLABS INC. 
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